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Nowo utworzo-
ne symbole mogą 
być dodane do no-
wej lub już istnieją-
cej biblioteki. Nowa 
biblioteka musi 
zostać powiązana 
z  projektem w  celu 
użycia umieszczo-
nych w niej symbo-

li. W  Capture CIS biblioteka symboli schematowych 
jest plikiem z rozszerzeniem OLB.

Tworzenie nowych symboli 
schematowych

Teraz dla przykładu utworzymy komponent 
LM317. W tym celu, poleceniem File> New> Library 
tworzymy nową bibliotekę, w efekcie czego powstaje 
nowy plik „library1.old” w strukturze projektu. Oczy-
wiście pod prawym klawiszem myszy dostępna jest 
możliwość zapisania tego pliku pod inną nazwą.

Proces tworzenia nowego symbolu schematowego 
na poziomie wybranej biblioteki rozpoczynamy po-
przez wydanie polecenia „New Part”, które pojawia 
się po naciśnięciu na bibliotekę prawym przyciskiem 
myszy. Nowe okno New Part Properties uzupełniamy 
tak, jak na rysunku 9. Po zatwierdzeniu wprowadzo-
nych informacji, pojawia się pole edycyjne z zarysem 

nowego symbolu 
oraz predefinio-
wanym miejscem 
na wyświetlenie 
przyszłego, unikal-
nego, numeru re-
ferencyjnego oraz 
wartości elementu. 
Wartością w  przy-
padku układów 
scalonych jest ich 
nazwa.

Piny, które definiują połączenie elektryczne 
umieszczamy po wydaniu polecenia Place -> Pin 

OrCAD i Allegro (2)
Kontynuujemy kurs tworzenia schematów elektrycznych za pomocą oprogramowa-
nia OrCAD i Cadence Allegro. W poprzednim miesiącu omówiliśmy sposoby zainstalo-
wania programu, jego konfigurowania, utworzenia nowego projektu oraz umieszcza-
nia gotowych komponentów na schemacie. Teraz skoncentrujemy się na tworzeniu 
własnych symboli schematowych oraz definiowaniu sieci połączeń.

(rysunek  10). Wszystkie 
piny można umieścić 
sekwencyjnie, jeden 
po drugim a  następnie 
poddać je indywidual-
nym poprawkom w  try-
bie edycji. Tryb 
edycji symbolu 
u r u c h a m i a m y 
podwójnym klik-
nięciem myszy na 
wybrany pin (ry-
sunek 10).

Można rów-
nież edytować 
wszystkie lub wy-
brane piny jed-
nocześnie, W  tym 
celu należy zaznaczyć interesujące piny i wydać pole-
cenie Edit Properties dostępne pod prawym klawiszem 
myszy, tak jak to pokazano na rysunku 11. Docelowo, 
definicje wyprowadzeń powinny wyglądać tak, jak na 
rysunku 11b.

Po umieszczeniu pinów należy zdefiniować gra-
ficzną reprezentację symbolu. Prostokąt narysowany 
przerywaną linią, do którego są przyczepione piny nie 
będzie wyświetlany na schemacie. Dlatego należy umie-
ścić brakujące elementy graficzne w postaci linii, okrę-
gów, łuków itd. 
Symbol może 
być reprezento-
wany dowolnie 
skomplikowaną 
grafiką. Potrzeb-
ne narzędzia 
graficzne są do-
stępne w  menu 
oraz w  postaci 
ikonek po prawej stronie interfejsu. Docelowo, symbol 
powinien wyglądać tak, jak na rysunku 12.

Do symbolu schematowego można dowiązać do-
wolną liczbę cech, właściwości. Określają one wła-

Aby uruchomić przykłady zamieszczone w tym kursie należy pobrać oprogramowanie FlowCAD Evalu-
ation Kit, który jest kompletnym środowiskiem testowym zawierającym dokumentację, pliki projektów 
i wszystkie potrzebne biblioteki. Środowisko to jest dostępne na stronie www.FlowCAD.pl po uprzed-
niej rejestracji. Z uwagi na ograniczoną objętość tego artykułu, opisujemy jedynie wybrane funkcje pa-
kietu. Po zainstalowaniu programu OrCAD/Allegro w katalogu „doc” znajdą się kompletne, oryginalne, 
podręczniki w formacie PDF oraz HTML.

Rysunek 9. Sposób uzupełnie-
nia danych nowego kompo-
nentu

Rysunek 10. Dodawanie wypro-
wadzeń tworzonego kompo-
nentu

Rysunek 11. Sposób a) zazna-
czenia i b) jednoczesnej edycji 
właściwości wielu wyprowadzeń

Rysunek 12. Wygląd graficzny 
nowego komponentu LM317
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ściwości elektryczne, sposób użycia i  wiele innych 
ważnych parametrów, które będą miały znaczenie 
w dalszym etapie projektowania. Właściwości można 
definiować na poziomie symbolu schematowego lub 
później – na schemacie. Baza danych CIS przechowuje 
zwykle zbiór typowych właściwości zdefiniowanych 
wcześniej dla symboli. Właściwości na poziome sym-
bolu definiuje się po wydaniu polecenia Options -> 
Properties.

Często się zdarza, że footprint ma więcej padów 
niż symbol schematowy pinów. Wymaga się jednak 
aby ilość pinów i  padów była równa. Przekładowo, 
trójwyprowadzeniowa obudowa SOT23 jest często 
używana dla diod półprzewodnikowych, które mają 
dwa piny (rysunek 13). W  takim przypadku wymaga 
się dodania właściwości „NC” (not connected pin) do 
symbolu schema-
towego w  celu 
wskazania nie-
podłączonych pi-
nów. W  tym celu, 
w  okienku „User 
Properties”, wy-
bieramy „New” 
i wstawiamy war-
tość „NC” do pola 
„Name” oraz „3” 
do pola „Value”. Rezultat jest widoczny w oknie „User 
Properties” (rysunek 14). W ramach ćwiczenia, pole-
camy bliższe przyjrzenie się symbolowi DDR3_2GB_
X16_SDRAM z biblioteki FC_Memory.

W  przypadku elementów o  dużej liczbie wypro-
wadzeń bardzo wygodne jest posłużenie się tabela-
rycznym interfejsem do tworzenia nowych symboli 
schematowych. Jeśli tworzymy bardzo duże symbole, 
reprezentujące np. procesory lub układy FPGA, war-
to rozważyć ich podział na sekcje. Każda sekcja jest 

Rysunek 13. Przykład elementu o dwóch wyprowa-
dzeniach schematycznych i trzech padach

Rysunek 14. Właściwości ele-
mentu po zaznaczaniu jednego 
pinu jako niepodłączonego

Rysunek 15. Widok cech wyprowadzeń elementu 
o niemałej liczbie pinów
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szy kalkula-
cyjnych.

N a j b a r -
dziej popu-
larną metodą 
d o d a w a -
nia nowego 
ko m p o n e n -
tu do bazy 
danych jest 
bezpośredni 
wpis do od-
p o w i e d n i e j 

tabeli. W  ramach ćwiczenia polecamy dodanie no-
wego układ scalonego do tabeli 5 – IC-Digital, którą 
zdefiniowano w bazie danych w formacie programu 
Microsoft Access, w pliku FlowCAD_Evalutaion_Kit\
site\library\de_cis\FC_lib_163.mdb. Po wpisaniu no-
wego elementu jest on widoczny w przeglądarce CIS 
Explorer programu Capture.

W  każdej chwili projektant może też dodać nowy 
element do bazy danych z poziomu Capture CIS bez ko-
nieczności użycia programu Access. W tym celu w oknie 
CIS Explorer zaznaczamy komponent i wybieramy pole-
cenie Edit -> Derive New Database Part (rysunek 17). 
W oknie New Database Part dokonujemy wymaganych 
zmian, np. typu footprintu, wysokości, itd. (rysunek 18). 
Wybieramy Place Part i potwierdzamy fakt wprowadze-
nia nowego komponentu. Nowa pozycja dodana w bazie 
danych będzie miała tymczasowy part numer, co pozwo-
li na szybkie odnalezienie komponentu i  uzupełnienie 
pozostałych wartości. Ważne jest to, że tak długo jak 
komponent ma tymczasowy Part Number, tak długo jest 
uznawany za niezweryfikowany, ale mimo to projektant 
może dalej z tym elementem pracować.

Definiowanie sieci połączeń
Po wprowadzeniu komponentów do bibliotek oraz 

ułożeniu ich w oknie edytora schematów, należy utwo-
rzyć sieć połączeń. Następnie, na podstawie wygene-
rowanej netlisty fizyczne elementy elektroniczne będą 
mogły być połączone ścieżkami. Sieci definiowane na 
poziomie schematu mogą nieść dodatkowe informacje 
w postaci atrybutów pomagających w procesie projek-
towania fizycznych ścieżek. Możemy wpływać na wła-
ściwości fizyczne, takie jak: minimalna szerokość albo 
też cechy elektryczne, np. oznaczając wybrane sieci 
jako pary różnicowe czy kategoryzując je jako ścieżki 
zasilające lub sygnałowe.

reprezentowana osobnym symbolem, co wydatnie 
poprawi czytelność schematu oraz ułatwi zaprojekto-
wanie połączeń. Jako przykład użyjemy dokumentację 
układu ICS557-05A zamieszczoną w pliku ics557-05a.
pdf, który jest zapisany w katalogi „play”. Ważne jest 
aby otworzyć ten plik w przeglądarce Acrobat w wer-
sji co najmniej 8.

W Capture CIS na poziomie biblioteki wydajemy 
polecenie dostępne pod prawym klawiszem myszy: 
New Part from Spreadsheet lub wybieramy z menu: 
Design -> New Part from Spreadsheet. W oknie New 
Part Creation Spreadsheet wpisujemy „ics557-05a” 
jako Part Name oraz „U” jako Part Ref Prefix.

W  pliku ics557-05a.pdf na stronie 3 znajduje się 
tabela Pin Descriptions.

Używając klawisza Alt pod-
czas zaznaczania możemy wy-
brać zawartość poszczególnych 
kolumn, dzięki czemu posługując 
się dodatkowo sekwencją CTRL-C 
(Copy) i  CTRL-V (Paste) możemy 
łatwo przekopiować potrzebne 
informacje do właściwych ko-
lumn w oknie New Part Creation 
Spreadsheet. Po przekopiowa-
niu danych z  tabeli Pin Descrip-
tions uzupełniamy pozostałe pola 
w oknie New Part Creation Spre-
adsheet, tak jak na rysunku 15:

•	 PinGroup – doprowadzenia 
o tym samym numerze w polu 
PinGroup są sobie równorzędne i mogą być między 
sobą wymieniane (swap). W podanym przykładzie 
taka sytuacja nie występuje, więc pole PinGroup 
powinno zostać niewypełnione.

•	 Position – określa pozycje pinu w  docelowy wy-
generowanym prostokącie. Możliwe są pozycje na 
wszystkich bokach prostokąta.

•	 Section – numer sekcji pozwala na podział symbo-
lu na większą liczbę symboli składowych. W na-
szym przykładzie nie ma sekcji.
Zanim nowy symbol zostanie zachowany, należy 

zwrócić uwagę na nazwy pinów, które muszą być uni-
kalne dla wszystkich ich typów za wyjątkiem typu po-

wer. W tej sytuacji 
należy zmienić 
nazwy pinów CLK, 
w  sposób pokaza-
ny na rys. 15. Pole-
cenia Save i  Con-
tinue spowodują 
zapisanie nowego 
symbolu do bi-
blioteki. Podwójne 
kliknięcie na nowy 
symbol w  biblio-
tece (rysunek 16) 
pozwoli na jego 
otwarcie. W  przy-
padku tworzenia 
symboli o  bardzo 
dużej liczbie wy-
prowadzeń, warto 
użyć edytora arku-

Rysunek 19. Sposób dodawania połączeń pomiędzy 
stronami schematów

Rysunek 18. Sposób dodawania 
nowego elementu z poziomu okna 
CIS Explorer

Rysunek 16. 
Drzewo projektu 
zawiera również 
symbole dodane 
do bilbioteki

Rysunek 17. Sposób wywoła-
nia funkcji dodawania nowego 
elementu z poziomu CIS 
Explorer
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Więcej informacji:
FlowCAD Poland, ul. Sąsiedzka 2A, 80-298 Gdańsk,
tel. 58 732 74 77, faks 58 732 72 37, support@flowcad.pl, www.FlowCAD.pl

Rysunek 23. Docelowa sieć połączeń w omawianym przykła-
dzie

Duże projekty zawierające schematy o wielu stro-
nach dodatkowo połączonych hierarchicznie, wyma-
gają jasnych zasad dotyczących łączenia sieci. Na po-
jedynczej stronie schematu połączenie komponentów 
wykonuje się graficznie, za pomocą linii wire. Jeżeli 
sieć ma nazwę (alias), to sieci o tych samych nazwach 
też są połączone, ale dotyczy to tylko bieżącej strony.

Sieci pomiędzy różnymi stronami tego samego 
schematu mogą być połączone tylko za pomocą łącz-
nika off-page connector (rysunek 19). Połączenie defi-
niują łączniki o tej samej nazwie położone na różnych 
stronach tego samego schematu. Inne, niepodłączone 
do łączników sieci, zde-
finiowane na różnych 
stronach schematu nie 
są ze sobą łączone na-
wet, gdy mają takie 
same nazwy. Podejście 
takie bardzo ułatwia 
wykorzystywanie ob-
cych fragmentów sche-
matów, ponieważ pro-
jektant jest zwolniony z obowiązku kontroli nazw sieci 
w celu uniknięcia powstania niepożądanych połączeń.

Jeżeli schematy są połączone hierarchicznie, to 
sieci są definiowane wyłącznie poprzez porty. Po-
zwala to na pracę grupową oraz powtórne wyko-
rzystanie schematów użytych w  innych projektach 
(rysunek 20).

W celu wykonania ręcznego połączenia wybiera-
my z menu Place -> Wire lub klikamy w ikonę odpo-
wiadającą tej opcji. Połączenia mogą być wykonane 
między niepodłączonymi doprowadzeniami kompo-
nentu lub między istniejącymi sieciami. Niepodłą-
czone piny są oznaczone charakterystycznym kwa-
dratem. Zakończenie 
połączenia definiuje 
się podwójnym klik-
nięciem. Sieci, które 
się przecinają mogą 
być ze sobą połączo-
ne, jeżeli w  punk-
cie przecięcia jest 
umieszczony obiekt 
Junction (polecenie 

Rysunek 20. Sposób dodawania połączeń hierar-
chicznych

Rysunek 21. Nadawanie 
własnych nazw sieciom

Rysunek 22. Definiowanie 
globalnej sieci zasilania

Place -> Junction). W celu usunięcia sieci wystarczy 
ją wybrać i użyć polecenia Edit -> Delete.

W  celu wykonania automatycznego połączenia 
wybieramy Place -> Auto Wire lub jedną z ikon odpo-
wiadających tym poleceniom. Polecenia z grupy „Auto 
Wire” pozawalają na automatyczne projektowanie po-
łączeń dla dwóch lub większej liczby wyprowadzeń 
oraz automatyczne, jednoczesne, dołączanie większej 
liczby pinów do magistrali. Więcej informacji o funk-
cji Auto Wire można znaleźć w nocie aplikacyjnej, któ-
ra znajduje się w pliku (dostępnym po zainstalowaniu 
pakietu) FlowCAD_Evalutaion_Kit\Documentation_
english\Other Documents\01_DECIS_Auto_connect.
zip.

Nadawanie nazw sieciom lub magistralom nie jest 
obowiązkowe, gdyż są one nadawane automatycznie. 
Aby zmienić nazwę na łatwiejszą do zapamiętania, 
należy użyć polecenia Place -> Net Alias. W  oknie 
Place Net Alias (rysunek 21) wpisujemy nazwę sieci 
i poprzez kliknięcie wskazujemy kursorem sieć do na-
zwania. Nazwa magistrali o sygnałach od A0 do A7 ma 
postać [A0:A7].

Istnieje też możliwość tworzenia sieci globalnych, 
takich jak np. GND i VCC, gdyż często nie ma sensu 
stosować do nich ograniczeń właściwych do połączeń 
lokalnych. W  celu zadeklarowania nazwy sieci jako 
globalnej wystarczy umieścić na schemacie w dowol-
nym miejscu symbol Power lub Ground, które można 
znaleźć po wydaniu polecenia Place -> Power lub Pla-
ce -> Ground. Z okna Place Power lub Place Ground 
wybieramy symbol i  nadajemy wartość atrybutowi 
Name, np: „0.75VTT”, jak na rysunku 22. Posługując 
się poznanymi technikami wprowadzamy sieć połą-
czeń do schematu, by uzyskać wynik, tak jak na ry-
sunku 23.

W kolejnej części…
W trzeciej części kursu opisującego działanie edy-

tora schematów OrCAD/Allegro Capture omówimy: 
przypisywanie atrybutów, numerowanie komponen-
tów, kontrolę reguł projektowych, znaczniki, raporty 
BOM, obsługę menedżera komponentów i  tworzenie 
wariantów projektowych oraz generowanie netlisty.


